The Little EndNote How-To Book
EndNote Training
March 2017
Introduction

The first thing you need to know is this is not a manual. It will not tell you which operating system any given version of EndNote is compatible with or how much RAM you need to run EndNote. It will not try to cover each finicky detail of what EndNote can do.

So, what is it?

This is an ebook of instructions on how to accomplish specific tasks in EndNote, such as importing references from a specific online database. The author will try to keep the screenshots and instructions as current as possible, which means there may be frequent new editions of this book. The goal will always be the same, though—to teach you how to make EndNote do the things you want it to do.

Please note that menu colors may be different than those shown depending on your operating system and system color preferences.

Thank you for using EndNote!
# Table of Contents

## Introduction

---

## Table of Contents

1. **Installing EndNote**
   1.1 For Administrators
   1.1.1 Creating a Site License Installer for Windows
   1.1.2 The Site License Installer for Macintosh
   1.2 For Users
   1.2.1 A Custom Installation for a Site License Copy of EndNote on Windows
   1.2.2 A Custom Installation for a Single-User Copy of EndNote on Windows
   1.2.3 Uninstalling EndNote on Macintosh
   1.2.4 A Custom Installation for a Site License Copy of EndNote on Macintosh
   1.2.5 A Custom Installation for a Single-User Copy of EndNote on Macintosh

2. **Using Direct Export to Import References from Online Databases**
   2.1 Direct Export from Thomson Reuters Web of Science
   2.1.1 Using the Marked List
   2.1.2 Not Using the Marked List
   2.2 Direct Export from PubMed
   2.2.1 Using the Clipboard
   2.2.2 Not Using the Clipboard
   2.3 Browser Actions with Direct Export
   2.3.1 Firefox on Windows
   2.3.2 Firefox on Macintosh
   2.3.3 Google Chrome on Windows
   2.3.4 Google Chrome on Macintosh
   2.4 EndNote Online Plug-In for Direct Export
   2.4.1 Google Chrome on Windows

3. **Importing PDF Files and PDF Handling**
   3.1 Importing PDF Files
   3.1.1 Importing a Folder of PDF Files on Windows
   3.1.2 Importing a Folder of PDF Files on Macintosh
6.2.4 Selecting the EndNote Style for Your Citations and Bibliography ........................................77
6.2.5 Editing Citations in the Document .........................................................................................78
6.3 Cite While You Write in Microsoft Word 2011 for Macintosh ..............................................81
6.3.1 Installing the Cite While You Write Tools ............................................................................81
6.3.2 Adding Citations to a Document Using Insert Citation .......................................................81
6.3.3 Adding Citations to a Document Using Insert Selected Citations .......................................83
6.3.4 Selecting the EndNote Style for Your Citations and Bibliography ......................................84
6.3.5 Editing Citations in the Document.........................................................................................85

7 Collaboration: Sharing EndNote References ..............................................................................89
7.1 How Not to Share an EndNote Library .....................................................................................89
7.1.1 EndNote Libraries on “Cloud” Services ..............................................................................89
7.1.2 EndNote Libraries on Network Servers ..............................................................................89
7.1.3 Sending the .enl File for a Library When Sharing a Library ..............................................89
7.2 Sharing Full EndNote Libraries ...............................................................................................90
7.2.1 Unlimited Attachment Space in EndNote Online ..................................................................90
7.2.2 Full Library Sharing ..............................................................................................................90
7.3 Share Groups in EndNote Online ...........................................................................................95
7.3.1 Creating an EndNote Online Library ..................................................................................96
7.3.2 Share Your Group in EndNote Online ................................................................................96
7.3.3 What the User You Shared Your Group with Will See .......................................................98
7.4 Put a Read-Only EndNote Library on a Network Drive .........................................................98
7.5 Send a Compressed Library .....................................................................................................99
7.6 The Traveling Library ..............................................................................................................101
7.6.1 Using the Traveling Library to Create Bibliographies in Shared Documents ..................101
7.6.2 Exporting the Traveling Library ..........................................................................................103
7.7 Summary Comparison of Sharing Methods .............................................................................105

8 Using the Label Field as a Custom Identification Number .......................................................106
8.1 Set the Label Field to Show in the Library Display ...............................................................106
8.2 Make a Backup of the Library ..................................................................................................107
8.3 Copying the Record Number to the Label Field ......................................................................108
8.4 Setting Cite While You Write to Use the Label Field .............................................................112

Index of Topics ..........................................................................................................................113
1 Installing EndNote

This chapter will have two main sections, one for administrators who want to create basic site license installers for their EndNote users, and one for users. Both sections will be detailed, with step-by-step instructions and screenshots.

EndNote can be installed on multiple computers just as a single user would install it, entering the product key for every installation. However, it is not necessary to enter the product key for every installation if the administrator creates or uses a site license installer.

Please note that you will need an administrative level of access sufficient to install software on your computer and that security software or operating system security settings may stop the installation process at various times and ask your permission to continue. You must choose the option to continue for the software to be installed.

Please also note the network administrator instructions will only work for site license/volume installations. They will not work for single-user installations.

1.1 For Administrators

1.1.1 Creating a Site License Installer for Windows

A site license installer for Windows consists of two files: 1) ENX8Inst.msi and 2) license.dat. These two files can be distributed to users and the user can install EndNote on their computer without knowing the site’s product key for the installation. Anybody with knowledge of the product key for the site can create a basic site installer, with no programming knowledge needed.

• Download the EndNote Windows installer from http://download.endnote.com/downloads/X8/ENX8Inst.msi (the address is case-sensitive and must be typed exactly as shown).

• Download the ADMIN.zip file from http://kbportal.thomson.com/utility/getfile.aspx?rid=8452 (the address is case-sensitive and must be typed exactly as shown).

• Extract the ADMIN.bat file by right-clicking on the ADMIN.zip file and selecting Extract All, as shown below.

• This will result in a folder with the ADMIN.bat file inside it. Put the ADMIN.bat file and the ENX8Inst.msi file together in the same folder or on the desktop. They must be in the same location to create a site installer.

• Double-click on the ADMIN.bat file to begin creating the site installer.
• When the window below appears, click the Next button.

• In the next window, fill in your school, company, or agency name and the product key. Mark the box to acknowledge that you have read and accept all terms of the license agreement. Then click the Next button.
• In the window below, use the *Browse* button to select the location the site installer will be created in, then click the *Next* button. Do *not* mark the option "Perform administrative installation."

![Select Destination](image1.png)

• Then click the *Next* button again in the window below.

![Admin Installation Verify Ready](image2.png)
• Then the *Finish* button in the window below.

![EndNote X8 Setup](image)

• You should see the site installer files together in your target folder, as shown below. You may now distribute these two files to users. Some schools zip the files together to make them easier to distribute. If you decide to zip the files, the user will need to extract them before running the installation. The installer will not run from a zipped file.

![Site Installer Files](image)

1.1.2 The Site License Installer for Macintosh

Because of changes made in OS X 10.12, Sierra, it is no longer possible for sites to create their own site license installers for Macintosh. Clarivate Analytics will create all site license installers for Macintosh. The site license administrator for each site will receive a link to download their custom installer for Macintosh when they receive their product key. The downloaded site license installer can then be distributed to users.

1.2 For Users

1.2.1 A Custom Installation for a Site License Copy of EndNote on Windows

A typical installation of EndNote installs less than 500 styles, 500 filters, and 500 connection files to EndNote, even though there are thousands of styles, as well as many more filters and connection files. A custom installation allows the user to add extra sets of styles, filters, and connection files to EndNote. For example, a user could add all the humanities styles available to the typical set.
If you have a previous version of EndNote installed, you should uninstall it using Control Panel before installing the new version.

Your school, company, or agency will need to provide you with two files to install the program, an ENX8Inst.msi installer and a license.dat file. These two files must be together in the same folder for the installation to run without asking for a product key. If you are given a zipped file containing these two files, as in the example file shown below, you will need to extract them from the zipped file before running the installer. Right-click on the file, then select the Extract All option as shown below.

- Use the Browse button to select the folder the files will be placed in after extraction, then click the Extract button.

- The files will be extracted to the selected folder. Keep the two files together and double-click on the ENX8Inst.msi file to start the installation.
• In the window below, click the **Next** button to continue.

![EndNote X8 Setup](image1)

• Click the **Accept** button to confirm that you have permission from your organization to install the EndNote software. If you do not have permission, you should not install the software.

![EndNote X8 Setup](image2)
Next you will see the window below, where you can review the Read Me Information. Then click the Next button to continue.

In the window below, read and accept the EndNote end user license agreement before you click Next to continue the installation.
In the window below, decide if you will perform a typical installation or a custom installation. If you select a Typical installation, a limited set of popular styles, filters, and connection files will be installed. If you select a Custom installation, you can choose which additional sets of styles, filters, and connection files will be added to the typical set. The remaining windows will show the options for a Custom installation.

By default, the program will be installed in the C:\Program Files (x86)\EndNote X8\ folder, but you can change this if you need to. It is best to leave it with the default location unless it is necessary to put it in another folder for some reason, such as a lack of space on the C drive. Click the Next button to continue.
• In the window below—
  1. Click the plus sign (+) by an option to open it for editing.
  2. Click the drop-down list button for the sets of styles, filters, or connection files you want to add. For this example, the set of all Arts and Humanities styles is selected.
  3. Select the Will be installed on local hard drive option to add that set of files to the default set.
  4. Click the Next button after making all your selections.

• Note: In the window above you could also click the option (for example, Additional Styles), then select the option Entire feature will be installed on local hard drive to install all the files for that option. Please remember for Styles that would install over 6,000 styles.
- Click the **Next** button again in the window shown below.

- If you see a window such as the one below, select **Yes**.
• Click the **Finish** button when you see the window below saying EndNote has been successfully installed. You are now ready to begin using EndNote.

![EndNote X8 Setup](image)

**Important:** Save a copy of the installation files in a safe place in case you need to install EndNote again in the future.

### 1.2.2 A Custom Installation for a Single-User Copy of EndNote on Windows

A custom installation for a single user will proceed just as it does for a site license user, except the program may be installed from a disk or from a single downloaded installation file. The user will be required to input a product key, then proceed from the *Read Me Information* as shown **above**.

### 1.2.3 Uninstalling EndNote on Macintosh

Previous versions of EndNote should be uninstalled before installing the current version.

• Close all EndNote libraries, then select **Customizer** from the **EndNote** menu to begin.
• In the *Customizer* window shown below, unmark all boxes, then click the *Uninstall* button.

• There will be a warning that all external EndNote components will be uninstalled. Click *Yes* to continue uninstalling EndNote.
• When the uninstall finishes you will see the window below. Click the **Exit** button, then drag the *EndNote* folder in *Applications* to the trash. If you have stored any personal libraries, styles, filters, or connection files in the *EndNote* folder, these should first be moved to the Documents folder. In general, it is best to keep these files in Documents.

• You are now ready to begin the installation, described in section 1.2.4 below.

1.2.4 A Custom Installation for a Site License Copy of *EndNote* on Macintosh

A typical installation of *EndNote* installs less than 500 styles, 500 filters, and 500 connection files to *EndNote*, even though there are thousands of styles, as well as many more filters and connection files. A custom installation will allow the user to add extra sets of styles, filters, and connection files to *EndNote*. For example, a user could add all the humanities styles available to the typical set.

Note that your Security & Privacy settings must allow apps downloaded from the Mac App Store and identified developers to install *EndNote*.

If you have a previous version of *EndNote* installed, you should uninstall it before installing the new version. You can find instructions for uninstalling recent previous versions of *EndNote* in section 1.2.3.

• You should receive a single file called *EndNote X8 Site Installer.dmg* from your site administrator like that shown below. Only a site installer can be used to install a permanent volume copy of *EndNote* without a product key. Double-click on the site installer to begin the installation.
• In the window below, **double-click the icon in the center** to begin the installation.

• Click the **Install** button.
• Click the **Next** button in the *Welcome to EndNote X8* window below.

![Welcome to EndNote X8](image1)

• Next you will see the window below, where you can review the *Read Me* information. Then click the **Next** button to continue.

![Read Me](image2)
• Then the **Done** button in the window below to complete the installation.

![EndNote X8 Customizer](image1)

• The first time you open EndNote, it will automatically create an EndNote library for you called "My EndNote Library" and place it in the Documents folder. It will also show the *Welcome to EndNote* guide below. When finished looking through the *Welcome to EndNote* guide you can close it using the **Close** button in the upper-left corner.

![Welcome to EndNote](image2)
• To add styles, filters, and connection files, select **Customizer** from the **EndNote** menu.

![Customizer menu](image1)

• Click the small arrow by **Connections, Import Filters, or Output Styles** to select the type of files you want to add, then mark the box(es) for the set(s) you want, and click the **Next** button.

![Select Components](image2)

• You will also have the option to customize Cite While You Write if you have not used standard settings while installing Microsoft Word. Click **Customize** if you have a nonstandard Word installation, otherwise click **Next**.

![Cite While You Write](image3)
• When the Customizer finishes, click **Done** to finish. You are now ready to begin using EndNote.

![EndNote Customizer Finish](image)

*Important:* Save a copy of the installation file in a safe place in case you need to install EndNote again in the future.

1.2.5 **A Custom Installation for a Single-User Copy of EndNote on Macintosh**

An installation for a single-user copy of EndNote will be very much the same as for a site-license copy, with the addition of needing to provide a product key the first time you open EndNote.
2 Using Direct Export to Import References from Online Databases

2.1 Direct Export from Thomson Reuters Web of Science

2.1.1 Using the Marked List

Web of Science’s marked list provides a useful way to keep track of the references you want to keep when browsing a large set of search results. References can be added to the marked list as you browse through them, then exported from the marked list later.

- Perform your search of the Web of Science.
- Mark the references you want to add to the marked list, and click on the Add to Marked List button.
- When ready to export, go to the marked list by clicking the Marked List button.
- You will see a window like the one below with three “steps” for options.

- Select the records you want to import in Step 1 of the window, shown below (usually “All records in this list” if 500 or less).
• Select the fields you want to import in Step 2. The example below is from a search of the Web of Science Core Collection. If you are searching databases outside the core collection, there will be fewer fields available.

![Image of EndNote X8 select fields](image.png)

• Select **Save to EndNote desktop** from the drop-down **Save to** list in Step 3.

![Image of EndNote X8 save options](image.png)

At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For Web of Science it will end with a .ciw extension.

- Firefox on Windows
- Firefox on Macintosh
- Google Chrome on Windows
- Google Chrome on Macintosh
- Safari on Macintosh

Safari does not support direct export.

2.1.2 Not Using the Marked List

• Perform your search on the Web of Science and select the references you want to import. Then select **Save to EndNote desktop** from the drop-down **Save to** list.
• You will see a window like the one below if you have selected references by marking them, and will not need to do anything further to select references.

![Send to EndNote window with 2 records selected](image1)

• If you have not selected references, you will see a window like this, and need to select either all the records on the page or a range of records.

![Send to EndNote window with options to select records](image2)

• With either of the options above, you will now need to select the fields to export. Select the Full Record option to get the keywords and author’s address as well as the main bibliographic information. Note that the Full Record option will only be available when you are searching the Web of Science Core Collection. If searching outside the core collection, select Author, Title, Source, Abstract.

![Send to EndNote window with Full Record option](image3)
• Then click the **Send** button.

![Send to EndNote dialog box](image)

• At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For Web of Science it will end with a .ciw extension.

  o Firefox on Windows
  o Firefox on Macintosh
  o Google Chrome on Windows
  o Google Chrome on Macintosh
  o Safari on Macintosh
    Safari does not support direct export.

### 2.2 Direct Export from PubMed

#### 2.2.1 Using the Clipboard

PubMed’s clipboard provides a useful way to keep track of the references you want to keep when browsing a large set of search results. References can be added to the clipboard as you browse through them, then exported from the clipboard later.
Perform your search of PubMed and mark the references you would like to add to the Clipboard on each page, then click on the **Send to** link to send the selected references to the Clipboard.

In the window shown below, select the **Clipboard** option, then click the **Add to Clipboard** button to add the selected references to the Clipboard. You can continue adding references to the Clipboard. Up to 500 references can be kept on the Clipboard for up to eight hours without activity.

After adding items to the Clipboard, you will see a **Clipboard** link to the right of the **Send to** link, telling you how many items are in the Clipboard. When you have finished adding items to the Clipboard and are ready to send them to EndNote, click the **Clipboard items** link.

In the Clipboard screen, click the **Send to** link, then select the **Citation Manager** option.
• Click the **Create File** button.

![Image](image.png)

• At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For PubMed it will end with a .nbib extension.

  o **Firefox on Windows**
  o **Firefox on Macintosh**
  o **Google Chrome on Windows**
  o **Google Chrome on Macintosh**
  o **Safari on Macintosh**

  Safari does not support direct export.

### 2.2.2 Not Using the Clipboard

• Perform your search of PubMed. You can mark the references you would like to export on each page if you wish. If you do not mark any references, all the references in the found set can be exported, in batches of up to 200 at a time. Click on the **Send to** link to begin the export process.

![Image](image.png)
• Then select **Citation Manager**.

![Citation Manager screenshot](image1)

• Select the number of references to export in the current batch, up to a maximum of 200 references.

![Citation Manager screenshot](image2)

• Keep track of the end number of the batch so you can repeat the export process for the next batch with the next consecutive record number. Then click the **Create File** button.

![Citation Manager screenshot](image3)
At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For PubMed it will end with a .nbib extension.

- Firefox on Windows
- Firefox on Macintosh
- Google Chrome on Windows
- Google Chrome on Macintosh
- Safari on Macintosh
  Safari does not support direct export.

2.3 Browser Actions with Direct Export

2.3.1 Firefox on Windows

- Your EndNote library should be open before attempting to import references.
- Firefox will bring up a window similar to the one below the first time a new export file type attempts to download. On Windows, you can choose the ResearchSoft Direct Export Helper option or you can click the Other button to select another program to open the file with.

![Opening savedrecs.ciw dialog](image)
• If you used the Other option, select the EndNote program to open the file in EndNote, then click the OK button.

• When returned to the window below, you may select the option to Do this automatically for files like this from now on. Please note there are several different files types that work with direct export and you will need to go through this process for each of these file types (.ciw, .ris, .ovd, .enw, .nbib).

• Click the OK button to finish the import into EndNote.
2.3.2 Firefox on Macintosh

- Your EndNote library should be open before attempting to import references.

- There is a known issue with direct export and EndNote libraries saved as a package (.enlp) on the Mac for some versions of EndNote. EndNote may ask you to select a library even though your library is already open when importing. Clicking “Cancel” will still import the references. Libraries not saved as packages will not have this problem. If your library is saved as a package, you can select Save a Copy from the File menu to create a copy of the file in the standard format. Do not select the option to save the copy as a package when prompted for the copy’s name and location. After creating your copy, use the copy as your new EndNote library instead of the packaged file.

- Firefox will bring up a window like the one below the first time a new export file type attempts to download. To have the file open in EndNote so the references will be imported, click the Choose button to open the file with an application.
• This should bring up a window like the one below. Navigate to the Applications/EndNote folder and select the EndNote application. Then click on the Open button.

• When returned to the window below, you may select the option to **Do this automatically for files like this from now on.** Please note there are several different file types that work with direct export, and you will need to go through this process for each of these file types (.ciw, .ris, .ovd, .enw, .nbib).

• Click the OK button to finish the import into EndNote.
2.3.3 Google Chrome on Windows

- Upon selecting the option to export from the online database, you will see the items below in the bottom left corner of the Chrome window. Select the option to Open. (Note that you can also select the option to Always open files of this type if you are absolutely sure you always want Chrome to open those files in EndNote in the future.)

- If you see the window below, click More apps to see a list of available applications. Unmark the box to always use this app to open files of this type unless you are absolutely sure you always want this type of file to be opened by EndNote.
You will then see a window similar to this, showing you a list of possible applications for opening the file. Select *EndNote* from the list. (Notes: This window may be different for different versions of Windows and Chrome. If you have installed the EndNote online plug-in for Internet Explorer and have previously set this file type to open, you may not see this window in Chrome. See section 2.4.1. for more information) Select the *EndNote* application. Once again, **unmark the box to always use this app to open files of this type unless you are absolutely sure you always want this type of file to be opened by EndNote**. Then click the **OK** button.

### How do you want to open this file?

- Look for an app in the Store
- Adobe Acrobat DC
- Adobe FrameMaker 2015
- Avast SafeZone Browser
- **EndNote X8 (Bld 10063)**
- GoldWave Digital Audio Editor
- Internet Explorer

☐ Always use this app to open .ciw files

[OK]

### 2.3.4 Google Chrome on Macintosh

The author has found the commands below to work only when using OSX 10.10, Yosemite, or later with Google Chrome. This has not worked with earlier versions of OSX.

- Upon selecting the option to export from the online database, you will see the item below in the bottom left corner of the Chrome window. Click the arrow to see a list of options.
• Select the option to **Open**. (Note that you can also select the option to **Always open files of this type** if you are absolutely sure you always want it to open those files in EndNote in the future.)

![Open window with savedrecs.ciw file](image1)

• If you see the window below, click **Choose Application** to see a list of available applications.

![Choose Application window](image2)

• Select the **EndNote** application in the **Applications/EndNote** folder, then click the **Open** button.

![Open EndNote application](image3)
2.4 EndNote Online Plug-In for Direct Export

2.4.1 Google Chrome on Windows

- If you have installed the EndNote online plug-in for Internet Explorer and you have set Google Chrome to Open file types that are used with direct export instead of save them, you will see a window like the one below when you use direct export. Select EndNote if you want the search results sent to your EndNote desktop library. Select EndNote Online if you want the search results sent to your EndNote online library. See section 5.2 for instructions for installing the plug-in.

- If you have not installed the Internet Explorer plug-in, you will need to follow the directions in section 2.3.3.
3 Importing PDF Files and PDF Handling

3.1 Importing PDF Files

EndNote can import PDF files containing a Digital Object Identifier (DOI) in the metadata or the first two pages of the PDF. EndNote sends the DOI to PubMed and CrossRef, online databases capable of looking up reference data by DOI. The online databases send back the bibliographic information, EndNote imports it, then attaches the PDF to the record created. This means the PDF must have a DOI and EndNote must have access to the Internet during the import.

3.1.1 Importing a Folder of PDF Files on Windows

- Select 1) Import from the File menu, then 2) Folder.
1) Click the **Choose** button, navigate to the folder you want to import, and double-click on it. It will appear in the **Import Folder** field.

2) If you wish to include subfolders within that folder, mark the box labeled **Include files in subfolders**.

3) If you want EndNote to create a separate group set for the main folder and groups within it for the subfolders, mark the box labeled **Create a Group Set for this import**. Leave the other settings at their defaults. (Note that EndNote will attempt to attach PDFs to matching records that already exist in the library instead of creating duplicate records.)

4) When all your options are set, click the **Import** button.

- The PDF files are imported. Below you see an example of the group set and groups that would be created for a folder called **PDF Examples** that contained a folder called **Bats** and a folder called **Birds**.

### 3.1.2 Importing a Folder of PDF Files on Macintosh

- Select **Import** from the **File** menu.
• Navigate to the location of the folder of PDFs you want to import. Select the folder, then click the Options button.

![Options button](image)

• In the Options, select **PDF File or Folder** if you do not want EndNote to create a group set and groups for the imported PDFs, or if you are only importing a single PDF. Select **PDF Folder as a Group Set** if you want EndNote to create a group set and groups for the imported PDFs. (Note: The rest of this example will show the group set option.)

![Options panel](image)

• Leave the other options at the default settings and click the Import button. (Note that EndNote will attempt to attach PDFs to matching records that already exist in the library instead of creating duplicate records.)

![Import options](image)

• EndNote will import the PDFs and create the group set and groups. (Example not shown.)
3.2 Setting PDF Handling

3.2.1 Windows

- Select Preferences from the Edit menu to open the EndNote preferences panel.

- Click the PDF Handling option in the preferences panel to see the window below. Here you can set automatic renaming options for PDFs you import or set a “watched” automatic importing folder. Any PDF added to the automatic importing folder will be imported into the EndNote library. (Note: You cannot put folders of PDFs in the automatic importing folder, only individual PDFs.) Click the OK button when you have finished selecting your options. (Note: A folder within the automatic importing folder will be created to hold PDFs after they have been imported, so you can easily tell which files have already been imported and which have not yet been imported.)
• The auto import folder will check for new PDFs when a library is opened. After opening the library, EndNote will scan for new additions to the folder on a schedule. If you continue working in EndNote and adding PDFs to the auto import folder, new PDFs added to the folder should be imported into EndNote within ten minutes of adding them to the folder, but you will need to be working in EndNote. If you have been working in another program and switch back to the EndNote window, but do not see your new additions, click on any reference in the list of references to trigger importing.

3.2.2 Macintosh

• Select Preferences from the EndNote X8 menu to open the EndNote preferences panel.

• 1) Click the PDF Handling option in the preferences panel to see the window below. Here you can set automatic renaming options for PDFs you import or set a “watched” automatic importing folder. Any PDF added to the automatic importing folder will be imported into the EndNote library. 2) Click the Save button when you have finished selecting your options, then 3) close the window.
4 Importing Text Files

Although direct export is a very popular way of importing references from online databases, data can also be saved as a text file and then imported. Two advantages of saving a text file and then importing it are—

1. Duplicates can be filtered out during the import process, before they enter the library.
2. If the Find Full Text preferences are set to Automatically invoke Find Full Text on newly imported references, then EndNote will automatically start searching for PDFs to match all the imported references as soon as the import is finished.

Importing works by pattern matching, so it is very important that the pattern of the data saved matches the pattern of the EndNote filter used to import it. Check the EndNote filter’s About This Filter section for instructions for downloading data in the correct format to match the filter.

Below are instructions for saving text files from two popular databases, the Web of Science and PubMed. You may need to download the latest Web of Science Core Collection (TR) filter from the EndNote web site to import the PMID.

4.1 Web of Science

4.1.1 Saving the Data from Web of Science

The method below uses the Web of Science Marked List and will allow you to import the PubMed PMID number into the Notes field of the EndNote record if you are searching the Web of Science Core Collection. The instructions are the same for both Windows and Macintosh.

- Perform your search in the Web of Science Core Collection.
- Mark the records you want to save and click the Add to Marked List button.
- After selecting all records, click the Marked List button.
In the Marked List, select 1) **All records in this list (up to 500)**, 2) the fields you want exported, and 3) the **Save to Other File Formats** option from the **Select Destination** drop-down list. Please note the PubMed ID field will only be available if you have limited your search to the Web of Science Core Collection.

In the window below, select 1) **Other Reference Software**, then click the **Send** button.
• If you see a window asking if you want to save the file or open it, such as the example below, save the file. Make a note of the location the file is saved in, EndNote will not know the location. Note that files saved in this way from the Web of Science have the default name savedrecs.txt. This file can be emailed to another EndNote user as an attachment for import, if desired. It is just a plain text document.

Opening savedrecs.txt

You have chosen to open:

.savedrecs.txt

which is: Text Document
from: http://ets.webofknowledge.com

What should Firefox do with this file?

☐ Open with Notepad (default)
☐ Save File
☐ Do this automatically for files like this from now on.

OK Cancel

4.1.2 Importing the Web of Science File on Windows

• To import the file into EndNote, in EndNote select 1) File, 2) Import, then 3) File.
• In the window below, 1) click the **Choose** button and select the **savedrecs.txt** file to open. You will need to know where you saved the file. Then 2) select **Other Filters** from the drop-down **Import Option** list. Note that after a filter has been used once, it will appear in the drop-down list in the future.

![Choose button and savedrecs.txt file](image)

1. Choose button
2. Savedrecs.txt file

• In the window below select 1) the **Web of Science Core Collection (TR)** filter, then click the **Choose** button.

![Choose an import filter](image)

1. Web of Science Core Collection (TR)
2. Choose button

Showing 377 of 377 import filters.
• If you think you might import duplicates of some of the references in your library, 1) choose *Discard Duplicates* from the *Duplicates* drop-down list, then 2) click the *Import* button.

![Import File dialog box](image)

• The references will be imported into EndNote and appear in the *Imported References* group. The PMID will appear in the Notes field as a number.

4.1.3 Importing the Web of Science File on Macintosh

• To import the file into EndNote, in EndNote select 1) *File*, then 2) *Import*.

![EndNote File menu](image)
• In the window below, 1) select the folder the file was saved in, 2) select the downloaded file, and 3) click the **Options** button.

![Folder selection](image1)

• In the options, select **Other Filters** from the **Import Options** drop-down list to bring up a list of import filters.

![Options](image2)

• In the window below select 1) the **Web of Science Core Collection (TR)** filter, then 2) click the **Choose** button.

![Choose filter](image3)
• If you think you might import duplicates of some of the references in your library, 1) choose Discard Duplicates from the Duplicates drop-down list, then 2) click the Import button.

• The references will be imported into EndNote and appear in the Imported References group. The PMID will appear in the Notes field as a number.

4.2 PubMed

4.2.1 Saving the Data from PubMed

Direct export from PubMed will allow importing of up to 200 records at a time, while saving a text file and then importing from PubMed will allow you to import thousands of records at a time if you wish to do so, and it will allow you to filter out duplicates during the import. The directions below use PubMed’s clipboard feature, but records can also be exported directly from the search results screen. Directions for saving data from PubMed are the same for Windows or Macintosh.

• Perform your search on PubMed’s web site.

• Mark the records you wish to import and 1) click the Send to: button, 2) choose Clipboard as the destination, and 3) click the Add to Clipboard button. This will add the selected references on the page to the clipboard. You can then go to the next page in PubMed and select more references.
• When finished selecting references, click the link showing the number of items in the Clipboard, to the right of the **Send to:** button. This will take you to the Clipboard.

![ Clipboard: 10 items ](image)

• In the Clipboard, 1) click the **Send to:** button, 2) select **File** under **Choose Destination**, 3) select **MEDLINE** as the **Format**, and 4) click the **Create File** button. Note that if you do not select the MEDLINE format, the file will not import into EndNote correctly.

![ Send to: Clipboard: items ](image)

• If you see a window similar to the one below, save the file and make a note of where you saved it. The default file name for files saved from PubMed is **pubmed_result.txt**. This is a plain text file and can be emailed as an attachment.

![ Opening pubmed_result.txt ](image)
4.2.2 Importing the PubMed file on Windows

- To import the file into EndNote, in EndNote select 1) **File**, 2) **Import**, then 3) **File**.

- In the window below, 1) click the **Choose** button and select the **pubmed_result.txt** file. You will need to know where you saved the file. Then 2) select **Other Filters** from the drop-down list. Note that after a filter has been used once, it will appear in the drop-down list in the future.
• In the window below, 1) select the *PubMed (NLM)* filter, then 2) click the *Choose* button.

![Choose An Import Filter]

• If you think you might import duplicates of some of the references in your library, 1) choose *Discard Duplicates* from the *Duplicates* drop-down list, then 2) click the *Import* button.

![Import File]

• The references will be imported into EndNote and appear in the *Imported References* group. The PMID will appear in the Accession Number field.
4.2.3 Importing the PubMed File on Macintosh

- To import the file into EndNote, in EndNote select 1) **File**, then 2) **Import**.

- In the window below, 1) select the folder the file was saved in, 2) select the downloaded file, and 3) click the **Options** button.

- In the options, select **Other Filters** from the **Import Options** drop-down list to bring up a list of import filters.
• In the window below, 1) select the **PubMed (NLM)** filter, then 2) click the **Choose** button.

![Choose A Filter window](image)

1. Select the **PubMed (NLM)** filter.
2. Click the **Choose** button.

• If you think you might import duplicates of some of the references in your library, 1) choose **Discard Duplicates** from the **Duplicates** drop-down list, then 2) click the **Import** button.

![Import Options window](image)

1. Choose **Discard Duplicates** from the **Duplicates** drop-down list.
2. Click the **Import** button.

• The references will be imported into EndNote and appear in the **Imported References** group. The PMID will appear in the Accession Number field as a number.
5 EndNote Online

EndNote lets you work on your desktop, online, or on an iPad. This chapter cannot cover everything EndNote can do online, but it will show you how using plug-ins and capture features of EndNote online can help you even if you prefer to work on the desktop.

Whether you are upgrading from EndNote basic (online only, with a limited feature set) and merging that library with your desktop library, or creating an online library for the first time, you need to start by setting up EndNote Sync to keep all your references and custom groups up to date on both the desktop and online.

5.1 Set Up EndNote Sync

5.1.1 Back Up the EndNote Desktop Library

First, you should make a complete backup copy of your desktop library by saving a compressed library. Note that EndNote may ask if you want to make a backup when you begin syncing, but you can make a backup at any time using the method below.

- Select **Compressed Library** from the **File** menu in EndNote. You should see a screen like the one below. Leave the options as shown to save a complete copy of your library with all attachments.

![Compressed Library dialog](image)

- Click on the **Next** button to select a location to save the file. This will bring up a standard “save” dialog window.
- Select the location and click the **Save** button. It may take some time to compress and save a large library, so be patient.
- Note that although you cannot safely keep a working EndNote desktop library in cloud services such as Dropbox, you can keep a compressed library in the cloud for backup purposes. See section 7.5 for more information.
5.1.2 EndNote Sync

- If you have not already synced your EndNote desktop and online library references, click the Sync button to sync for the first time. (Note that you may be asked if you want to create a compressed library as a backup if it is the first time the library has been synced on that computer.)

Sync button for Windows:  
Sync button for Macintosh:  

- If you already have an EndNote online or basic account, use that account's logon information, as in the example shown below. If you do not have an EndNote online account, you can create one by clicking the Sign Up button (in the box below). Click the OK button to start the sync.

- During the first sync, all references in both the EndNote desktop and online libraries will be copied to the other library, as well as all group information, but only custom groups will be displayed in EndNote online. So, there may be duplicates and some library clean-up necessary. After the first sync, any change made in any synchronized library will be reflected in all synchronized copies of the library. This means if you delete references in EndNote online or EndNote on the desktop, those references will be deleted in both.
• Group sets will not show online, but the information will be synced through online to a second desktop computer, where they will show. Because they do not show online, you may wish to use short prefixes before custom group names to ensure custom groups that belong together remain together online, as shown in the example below.

![EndNote desktop and online screens showing group sets](image)

- Although it is possible to create an EndNote online account and not synchronize it to an EndNote desktop library, syncing will allow you to easily keep the same set of references in both libraries.
- After syncing an EndNote library, you can begin sharing groups to collaborate with others. See section 7.3 for more information on this.

### 5.2 Installing the Internet Explorer Plug-In

You do not need to be using Internet Explorer to install the Internet Explorer plug-in. If you prefer to use another browser, such as Google Chrome or Microsoft Edge, but want the benefits of direct export with EndNote online, or if need to install the plug-in on several computers, use the .msi installer.

- On the Downloads page in EndNote online, select **Download Windows MSI for mass program installation**.

**Cite While You Write™**

Use the EndNote plug-in to insert references, and format citations and bibliographies automatically while you write your papers in Word. This plug-in also allows you to save online references to your library in Internet Explorer for Windows.

**U.S. Patent 8,082,241**

See Installation Instructions and System Requirements.
- **Save** the file in a location you will remember, such as the *Downloads* folder.
- Navigate to the location you saved the file and double-click the downloaded *EndNotePlugins.msi* file to begin the installation.

You will see a message that the installer is searching for installed applications. This message may remain for several minutes, so be patient.
• When the installer has recognized the presence of both Internet Explorer and Microsoft Word, this message will appear. Click the **Next** button to continue.

• Enter your name and company, then click the **Next** button.
• The Default server will work for most people. If you believe your school or organization requires a special server, check with your library for the server address your school or organization requires.

• You may change the destination folder the program will be installed in, if you wish, then click the Next button. In general, the default location is best.
Because you are using EndNote on both the desktop and online, you do not need the EndNote online Cite While You Write files. They are already contained in EndNote. From the drop-down **Cite While You Write for Microsoft Word** menu, select **Entire feature will be unavailable**. Then click the **Next** button.

Click the **Next** button on the **Ready to Install the Application** screen below. If your operating system requires permission to continue the installation, approve the installation.
• When the installation has completed, click the **Finish** button. You can now begin using the EndNote online for direct export.

5.3 Using Direct Export Online

Using direct export online works just as it does on the desktop, except that you are directing the references to your online library; so the steps shown in this booklet in the sections *Direct Export from Thomson Reuters Web of Science* or *Direct Export from PubMed* apply here, as well. Installing the plug-in for Internet Explorer will also enable direct export in Microsoft Edge or Google Chrome on Windows.

5.4 Capturing Multiple References

Capture is not the same thing as direct export, and can work differently for different web sites and databases. For some sites, it may only allow you to capture a single record, while for other sites a set of records. Below are examples of differences you might see with different browsers and different databases for multiple records.

For Google Scholar, you will need to use the Capture button with Internet Explorer and the Internet Explorer plug-in to export multiple references. The Capture bookmarklet will not work for multiple references from Google Scholar.

Please remember that the examples given below are only a few of the online sources Capture can be used with.
5.4.1 Installing the Capture Bookmarklet

5.4.1.1 Google Chrome and Safari
The steps to install the Capture bookmarklet are the same for Google Chrome and Firefox on both Windows and Macintosh, as well as Safari on Macintosh.

- On the Downloads page in EndNote online, locate the Capture Reference bookmarklet on the screen and drag it to the bookmarks bar (Chrome or Firefox) or favorites bar (Safari).

- A Capture Reference button will appear on the bookmarks bar (Chrome or Firefox) or favorites bar (Safari).

5.4.1.2 Safari on iPad
If you are synchronizing bookmarks between your Mac desktop and iPad and you have installed the Capture bookmarklet on your desktop computer, you should see a Capture Reference button appear on the favorites bar in Safari on the iPad. In general, it will work as it does on the desktop if you are also using the EndNote iPad app, but we have seen problems using it with sites that require scrolling.

5.4.2 Capture a Set of References from PubMed

- Perform your search in PubMed.
- By default, PubMed shows 20 results per page. Click on the Per page drop-down arrow, shown below, to show up to 200 records per page. The Capture will be for a single page of references at a time.

- Click the Capture button on the EndNote plug-in’s toolbar for Internet Explorer, or the Capture Reference bookmarklet button in other browsers. Below are the results you should see.
5.4.2.1 Results for Capture Button in Internet Explorer

- When the capture is finished, you should see a message that multiple references have been imported into your Unfiled group. You can continue capturing references one page at a time. (Please note that in Internet Explorer you could also use direct export to export up to 200 references at a time to either your online or desktop library.)

5.4.2.2 Results for Capture Bookmarklet in Google Chrome or Firefox on Windows

- When you see the screen below, which may take several moments to appear, select my.endnote.com to import the page of references to your EndNote online library or EndNote to import the references to your EndNote desktop library, then click the Capture button.

- If you selected my.endnote.com, you can also select the group to add the references to or you can create a new group for the references.

- If you selected EndNote, the browser will download the references as shown below.
• When you see the screen above, if using Chrome look in the status bar at the bottom of the screen, where you can select the option to **Open** the file.

![CaptureToDesktop.ris](image)

• At this point you can follow the direct export instructions found in section 2.3.3.

### 5.5 Capturing a Single Reference

• The Capture button can also be used to capture information from web sites such as YouTube, Amazon.com, online newspapers, etc. When looking at a newspaper article, video in YouTube, book information in Amazon.com, or similar web sites, click the **Capture** button in Internet Explorer or the **Capture Reference** bookmarklet in other browsers to capture the information on the site. You will see an editable record such as the one below, showing the data EndNote was able to capture.

![Capture New Reference](image)
• Select the option to save it to my.endnote.com to save it to your online library, with the option to save it to an existing group or create a new group, or select EndNote to save it to your desktop library.

• Edit the reference to add missing information or change the reference type, then click the Save to button to save the record.
6 Cite While You Write

EndNote’s Cite While You Write (CWYW) lets you look up references, insert them in your document, format your bibliography, and edit your citations to include page numbers or other text, all from within your word-processing document. Below are instructions for using Cite While You Write with Microsoft Word.

6.1 Cite While You Write in Microsoft Word on Windows

6.1.1 Installing the Cite While You Write Tools

When you install EndNote, it will automatically install files into a common program folder, allowing EndNote and Word to communicate and enabling Cite While You Write (CWYW). In Word for Windows you will see a tab on the ribbon similar to that shown below. (Note: It is best to close all other programs before installing EndNote, most especially Word and Outlook. When installing Word and EndNote on a new computer, always install Word first to enable EndNote to find it and be able to install the Cite While You Write tools.)

Below is information on using the Cite While You Write tools that you will need on a day-to-day basis.

6.1.2 Adding Citations to a Document Using Insert Citation

- Click in the top half of the **Insert Citation** button in Word to open the **Find & Insert My References** window.
• In the **Find & Insert My References** window that appears, enter your search terms and click the **Find** button, or press the **Enter/Return** key, to bring up a set of references that contain those search terms. The terms can be anywhere in the EndNote record, but all the terms must be present in the same record.

![EndNote X8 Find & Insert My References](image)

• Next, select (highlight) the reference(s) you want to insert. When you select a single reference, you will see the details for that reference in the bottom part of the window, but details can be shown for only a single reference. However, you can select multiple references for insertion by holding down the **Control** key and clicking on them, then selecting your insertion options from the **Insert** list.

![EndNote X8 Find & Insert My References](image)

• Your references will be inserted in the document and instantly formatted.
6.1.3 Adding Citations to a Document Using Insert Selected Citations

- To select the citations you will insert in the document, return to EndNote by clicking the Go to EndNote button.

- In EndNote, select (highlight) the references you want to insert. You have two choices for how you insert them in the document:
  - You can insert them in the document from EndNote using the first button of the set shown below, Insert Citation. (Note this is a different command than the Insert Citation button within Word, being the equivalent of the Insert Selected Citation(s) command in Word.) This will insert the references wherever your cursor is located in Word.
  - If you would like to check if your cursor is in the correct location and then insert the references from within Word, in EndNote click on the third button shown in the set below, Go to Word Processor.
  - If you returned to Word to insert the selected citations, click the bottom part of the Insert Citation button, then select Insert Selected Citation(s) from the drop-down list.

- Your references will be inserted in the document and instantly formatted.

6.1.4 Selecting the EndNote Style for Your Citations and Bibliography

- You can select your preferred style from the drop-down style list as shown below, or select the Select Another Style option to see the list of EndNote styles available on your computer. (Note that a typical installation of EndNote only installs a list of popular styles. You can perform a custom installation of EndNote to install more styles or download them from the EndNote web site. See section 1.2.1 for instructions for a custom installation of EndNote.)
• If you would like more control over the formatting of the citations and bibliography, such as the ability to change the line spacing or set hyperlinking options between the citations and bibliography, click the small arrow in the bottom right corner of the Bibliography group to open the Configure Bibliography window.

![Configure Bibliography window](image)

• The two tabs in the Configure Bibliography window provide options for changing the style, adding, removing, or formatting hyperlinks between citations and their matches in the bibliography, adding a centered title above the bibliography, changing the font used for the bibliography, and more. Select your options, then click the OK button to make your changes. Changing these options using Word commands would not create permanent changes; you must use the Configure Bibliography command to permanently change options such as font or line spacing in the bibliography.

![Configure Bibliography window](image)

6.1.5 Editing Citations in the Document

If you try to edit citations in a document by simply typing the page numbers into a citation or removing an author's name from a citation, the change will only be temporary and will disappear with the next update of the bibliography. Worse than that, you risk corrupting the citation codes, which would prevent EndNote from updating them and could cause other problems in your document. The safe way to make changes to the citations is using the Edit & Manage Citations command.

• Click on the citation you want to change, then click the Edit & Manage Citations button.

![Edit & Manage Citation(s)](image)
In the **Edit & Manage Citations** window there are two tabs in the lower part of the window. The first tab, **Edit Citation** (shown below), contains fields where you can add prefix or suffix text to a citation, as well as page numbers for those styles that require them. There is also a drop-down **Formatting** list that provides options to put the author’s name outside of the parentheses, exclude an author’s name, exclude the year, or show the reference only in the bibliography. (Note: If you are using a style where page numbers entered in the Pages field do not show, enter page numbers in the Suffix field, which will always show.)
• The second tab, Reference, shows the details for the selected (highlighted) reference in the top half of the window.
Along with being able to add text to citations, you can also use the **Edit Reference** drop-down list for each reference to add new citations to the grouped citation with the **Insert Citation** command, or safely remove citations from a grouped citation with the **Remove Citations** command. This is the safest way to remove citations from a document because it safely removes all the hidden coding. If the coding is not completely removed, it can result in a corrupted citation.

6.2 Cite While You Write in Microsoft Word 2016 on Macintosh

6.2.1 Installing the Cite While You Write Tools

When you install EndNote X7.5 or later it will automatically install files allowing EndNote and Word 2016 to communicate and enabling Cite While You Write (CWYW). In Word 2016 you will see a tab on the ribbon, similar to that shown below.

Below is information on using the Cite While You Write tools that you will need on a day-to-day basis.
6.2.2 Adding Citations to a Document Using Insert Citation

- Click the **Insert Citation** button on the EndNote tab in Word to open the **Find & Insert My References** window.

- In the **Find & Insert My References** window that appears, enter your search terms and press the **Enter/Return** key to bring up a set of references that contain those search terms. The terms can be anywhere in the EndNote record, but all the terms must be present in the same record.
Next, select (highlight) the reference(s) you want to insert. When you select a single reference, you will see the details for that reference in the bottom part of the window, but details can be shown for only a single reference. However, you can select multiple references for insertion by holding down the **Command** key and clicking on them, then selecting your insertion options from the **Insert** list.

Your references will be inserted in the document and instantly formatted.

### 6.2.3 Adding Citations to a Document Using Insert Selected Citations

- To select the citations you will insert in the document, return to EndNote by clicking the **Go to EndNote** button.

- In EndNote, select (highlight) the references you want to insert. You have two choices for how you insert them in the document:
  - You can insert them in the document from EndNote using the first button of the set shown below, **Insert Citation**. (Note this is a different command than the **Insert Citation** button within Word, being the equivalent of the **Insert Selected Citation(s)** command in Word.) This will insert the references wherever your cursor is located in Word.
If you would like to check if your cursor is in the correct location and then insert the references from within Word, in EndNote click on the third button shown in the set below, Return to Word Processor.

If you returned to Word to insert the selected citations, click the down arrow on the Insert Citation button, then select Insert Selected Citation(s) from the drop-down list.

- Your references will be inserted in the document and instantly formatted.

6.2.4 Selecting the EndNote Style for Your Citations and Bibliography

- You can select your preferred style from the drop-down style list as shown below, or select the Select Another Style option to see the list of EndNote styles available on your computer. (Note that a typical installation of EndNote only installs a list of popular styles. You can use the Customizer under the EndNote menu to install more styles or download them from the EndNote web site.)

- If you would like more control over the formatting of the citations and bibliography, such as the ability to change the line spacing or set hyperlinking options between the citations and bibliography, select Configure Bibliography from the Bibliography drop-down list to open the Configure Bibliography window.
• The two tabs in the **Configure Bibliography** window provide options for changing the style, adding, removing, or formatting hyperlinks between citations and their matches in the bibliography, adding a centered title above the bibliography, changing the font used for the bibliography, and more. Select your options, then click the **OK** button to make your changes. Changing these options using Word commands would not cause permanent changes; you must use the **Configure Bibliography** command to permanently change options such as font or line spacing in the bibliography. (Note: it is best **not to mark the box to Link in-text citations to references in the bibliography** until you have finished editing the document. If you mark this box, whenever you try to select a citation, EndNote will jump to the bibliography.)

![Configure Bibliography window](image)

### 6.2.5 Editing Citations in the Document

If you try to edit citations in a document by simply typing the page numbers into a citation or removing an author’s name from a citation, the change will only be temporary and will disappear with the next update of the bibliography. Worse than that, you risk corrupting the citation codes, which would prevent EndNote from updating them and could cause other problems in your document. The safest way to make changes to the citations is using the **Edit & Manage Citations** command.

• Click on the citation you want to change, then click the **Edit & Manage Citations** button.
In the **Edit & Manage Citations** window there are two tabs in the lower part of the window. The first tab, **Edit Citation** (shown below), contains fields where you can add prefix or suffix text to a citation, as well as page numbers for those styles that require them. There is also a drop-down **Format** list that provides options to put the author’s name outside of the parentheses, exclude an author’s name, exclude the year, or show the reference only in the bibliography. (Note: If you are using a style where page numbers entered in the Pages field do not show, enter page numbers in the Suffix field, which will always show.)
• The second tab, **Reference**, shows the details for the selected (highlighted) reference in the top half of the window.

![EndNote X8 Edit & Manage Citations](image1)

Along with being able to add text, remove the author name, or remove the year, you can also use the drop-down list for each reference to add new citations to a grouped citation with the **Insert Citation** command, or safely remove citations from a grouped citation with the **Remove Citations** command. This is the safest way to remove citations from a document because it safely removes all the hidden coding. If the coding is not completely removed, it can result in a corrupted citation.

![EndNote X8 Edit & Manage Citations](image2)
6.3 Cite While You Write in Microsoft Word 2011 for Macintosh

6.3.1 Installing the Cite While You Write Tools

When you install EndNote it will automatically install files allowing EndNote and Word to communicate and enabling Cite While You Write (CWYW). In Word 2011 you will see an EndNote menu under the Word Tools menu and an EndNote toolbar like the one below. (Note: It is best to close all other programs before installing EndNote, most especially Word and Outlook. When installing Word and EndNote on a new computer, always install Word first to enable EndNote to find it and be able to install the Cite While You Write tools. Also note that Word 2011’s Visual Basic must be installed to use Cite While You Write.)

If you installed Word after installing EndNote, you can run the Customizer to install the Cite While You Write tools by selecting Customizer from the EndNote menu.

Please note that floating toolbars in Word can be closed and reopened. If you have closed the toolbar and want to see it again, select View→Toolbars in Word, then select the EndNote toolbar.

Below is information on using the Cite While You Write tools that you will need on a day-to-day basis.

6.3.2 Adding Citations to a Document Using Insert Citation

- Click the Find & Insert My References button on the EndNote toolbar in Word to open the Find & Insert My References window.
In the **Find & Insert My References** window that appears, enter your search terms and press the **Enter/Return** key on your keyboard to bring up a set of references that contain those search terms. The terms can be anywhere in the EndNote record, but all the terms must be present in the same record.

- Pepperberg 2006 Grey parrot (Psittacus erithacus) numerical abilities: Addition and further experiments on a zero-like concept
- Pepperberg 1999 The Alex studies: Cognitive and commun...
• Next, select (highlight) the reference(s) you want to insert. When you select a single reference, you will see the details for that reference in the bottom part of the window, but details can be shown for only a single reference. However, you can select multiple references for insertion by holding down the Command key and clicking on them, then selecting your insertion options from the Insert list.

• Your references will be inserted in the document and instantly formatted.

6.3.3 Adding Citations to a Document Using Insert Selected Citations

• To select the citations you will insert in the document, return to EndNote by clicking the Go to EndNote button.

• In EndNote, select (highlight) the references you want to insert. You have two choices for how you insert them in the document.
  o You can insert them in the document from EndNote using the first button of the set shown below, Insert Citation. This will insert the references wherever your cursor is located in Word.
If you would like to check if your cursor is in the correct location and then insert the references from within Word, in EndNote click on the third button shown in the set below, *Return to Word Processor*.

If you returned to Word to insert the selected citations, click the *Citations* button, then select *Insert Selected Citation(s)* from the drop-down list.

- Your references will be inserted in the document and instantly formatted.

### 6.3.4 Selecting the EndNote Style for Your Citations and Bibliography

- To select the style for your citations and bibliography, select your preferred style from the drop-down style list as shown below, or select the *Select Another Style* option to see the list of EndNote styles available on your computer. (Note that a typical installation of EndNote only installs a list of popular styles. After installation, select *Customizer* from the *EndNote* menu to install more styles, or download them from the EndNote web site.)

- If you would like more control over the formatting of the citations and bibliography, such as the ability to change the line spacing or set hyperlinking options between the citations and bibliography, select *Configure Bibliography* from the drop-down *Bibliography* list.
• The two tabs in the **Configure Bibliography** window provide options for changing the style, adding, removing, or formatting hyperlinks between citations and their matches in the bibliography, adding a centered title above the bibliography, changing the font used for the bibliography, and more. Select your options, then click the **OK** button to make your changes. Changing these options using Word commands would not cause permanent changes; you must use the **Configure Bibliography** command to permanently change options such as font or line spacing in the bibliography. (Note: Because simply clicking on a hyperlink in a Word for Macintosh document will activate the link, it is best not to turn on hyperlinking between citations and bibliography until you are finished working with the document.)

![Configure Bibliography window]

6.3.5 Editing Citations in the Document

If you try to edit citations in a document by simply typing the page numbers into a citation or removing an author’s name from a citation, the change will only be temporary and will disappear with the next update of the bibliography. Worse than that, you risk corrupting the citation codes, which would prevent EndNote from updating them and could cause other problems in your document. The safe way to make changes to the citations is using the **Edit & Manage Citations** command.

• Click on the citation you want to change, then click the **Citations** button and select **Edit & Manage Citations**.
In the **Edit & Manage Citations** window there are two tabs in the lower part of the window. The first tab, **Edit Citation** (shown below), contains fields where you can add prefix or suffix text to a citation, as well as page numbers for those styles that require them. There is also a drop-down **Format** list that provides options to put the author’s name outside of the parentheses, exclude an author’s name, exclude the year, or show the reference only in the bibliography. (Note: If you are using a style where page numbers entered in the Pages field do not show, enter page numbers in the Suffix field, which will also show.)
• The second tab, **Reference**, shows the details for the selected (highlighted) reference in the top half of the window.
• Along with being able to add text to citations, you can also use the drop-down list at the right of each reference to add new citations to a grouped citation with the **Insert Citation** command, or safely remove citations from a grouped citation with the **Remove Citations** command. This is the safest way to remove citations from a document because it safely removes all the hidden coding. If the coding is not completely removed, it can result in a corrupted citation.
Collaboration: Sharing EndNote References

An EndNote library is not a single file. It is a set of files, many of them frequently updated as you work, and these files must be updated in a strict sequence by EndNote to avoid corruption of the library. This can cause difficulties when sharing libraries because only EndNote can properly control the sequence for updating and saving of data in the library, and outside synchronization or file management services can actually damage EndNote libraries. This section covers some of the methods to avoid, and then talks about safer methods of sharing references or complete libraries.

7.1 How Not to Share an EndNote Library

7.1.1 EndNote Libraries on “Cloud” Services

Never store an EndNote working library on any cloud service for sharing, or even just for your own use on multiple computers. This will eventually lead to library corruption because of the way the cloud services synchronize files over the Internet. Such unusable cloud services would include, but are not limited to—

- Amazon Cloud
- Box
- Dropbox
- Google Drive
- SharePoint
- OneDrive
- SugarSync

Also, never store a working library on a flash drive.

The reason these methods are inadvisable is that when you are working in EndNote, it is saving data to multiple files, and the data must be saved in a set sequence, as described above. When cloud services transfer that data, they may change the sequence of file saves. This eventually leads to library corruption. The library may appear to be fine for days, weeks, or even months, but will eventually be corrupted.

7.1.2 EndNote Libraries on Network Servers

EndNote libraries with read-write access should not be stored on network drives. We have seen corruption problems with libraries on network drives as well as general performance issues. Ideally, the library should be kept on the owner’s computer. If you must keep a library with read-write access on a network drive, we suggest you make frequent backups of the library using the File ➔ Compressed Library command for libraries smaller than 5G or the File ➔ Save A Copy command for larger libraries.

7.1.3 Sending the .enl File for a Library When Sharing a Library

Every EndNote library is made up of two parts: the .enl file and the .data folder, as seen below.
It may be helpful to think of the .enl file as just the interface file for working with the contents of the .data folder, where all the real data is kept. When you open a .enl file, EndNote searches for the matching .data folder and refreshes the screen with the latest information in a sort of “snapshot.” If the .data folder is removed, EndNote will create a new one with data to match the last “snapshot” because it must have a .data folder to work. However, that new .data folder would not contain any of the attachments, group structure, or term lists from the original library; it would contain only the reference data. If you send somebody the .enl file only, they will receive only a portion of the library.

So how can you share EndNote references safely?

### 7.2 Sharing Full EndNote Libraries

The EndNote X7.2 update introduced two much-requested features to EndNote:

1. Unlimited attachment space in EndNote online.
2. Full library sharing for up to fifteen people, including the library owner. This was expanded to up to 101 people, including the owner, in EndNote X8.

#### 7.2.1 Unlimited Attachment Space in EndNote Online

Prior to EndNote X7.2, users were limited to 5 gigabytes of attachment space in EndNote online. For EndNote X7 or X8 users, that limit has been removed. As in EndNote on the desktop, an unlimited number of files of any type can be synchronized to and stored in EndNote online — PDFs, Word documents, PowerPoint presentations, even audio or video files — and through EndNote online those attachments can sync with up to three computers per user (for a single-user license of EndNote, site licenses may have restrictions on outside installations of the software).

Please note that EndNote basic users will still be limited to 2 gigabytes of attachment space.

#### 7.2.2 Full Library Sharing

##### 7.2.2.1 The Basics

In the past, there was no way for users to share simultaneous access to a complete EndNote library with full read-write permissions and attachments. Full libraries could be shared on a network server with read-only access for simultaneous use, but only the owner could make changes, or groups could be shared through EndNote online, but without attachment sharing. Plus, to share a group online
required the sharer to know the email address for the “sharee’s”¹ EndNote online account. Users of EndNote X7.2 or later can share their entire library, with simultaneous read-write access to all references and attachments, with other users of EndNote X7.2 or later. The basic requirements and information for sharing are—

All users must be using EndNote X7.2 or later.

EndNote X8 users can share a library with up to 100 people; EndNote X7 users can share a library with up to fourteen other people.

All users must sync their EndNote desktop and online libraries. The sharing process works through EndNote Sync.

A library owner can sync only one EndNote library, so only one library can be shared with others or synced to the owner’s other computers or iPad.

Although a library owner is limited in how many users they can share a library with, an unlimited number of libraries can be shared with a sharee.

Because the entire library is synced to all recipients, with attachments, the library will take up as much space on the recipient’s computer as it does on the owner’s computer and can be used off-line. However, the library can only be accessed through the File ➔ Open Shared Library command in EndNote.

The sharee will have full access to the library, this means they can add, change, or delete references and attachments. We suggest the owner make frequent backups of their library using the File ➔ Compressed Library command.

7.2.2.2 How to Share a Library

- If you have not already synced your EndNote desktop and online libraries, click the Sync button to sync for the first time. (Note that you may be asked if you want to create a compressed library as a backup if it is the first time the library has been synced on that computer. We strongly suggest making a backup before the first sync. See section 5.1 for more details on syncing an EndNote library for the first time.)

In your synced library, click the Share Library button.

¹ The word “sharee” will be used throughout this section to designate the person a library is shared with.
Enter the email address of the person you want to invite to the shared library, then click the **Invite** button. The email address does not need to be the one the invitee/sharee uses for their EndNote online account.

![Sharing dialog](image)

You are sharing your library with 2 people out of a possible 100.
• The invitee’s name will be added to the list at the top of the dialog with a *Pending* status to show they have not yet accepted the invitation. If you want to send a reminder of the invitation or remove them from the list, you can do that at any time.

![Sharing dialog](image)

• The invitee will receive an email inviting them to the shared library. They must click the *Accept* button in the email to accept the invitation.

• The invitee will be directed to the page below, where they must logon to the EndNote online account they sync through. If they do not have an EndNote online account, they can create one here.

![Sign In page](image)
• The invitee will receive a notification that they are ready to access the shared library. There will be additional information on this page. Remember they must be using EndNote X7.2 or later to access the shared library.

![You're ready to access this shared library!](image)

Updating to X7.2

Now, go to the desktop to make sure you're on the latest version. To check:

**Windows**
1. Click on Help > About
2. Click on Program Updates or download the installer.

**Mac**
1. Click on the EndNote X7 menu dropdown.
2. Click on Check for Updates or download the installer.

• To open a library that has been shared with you in EndNote, select **File ➔ Open Shared Library**.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>References</th>
<th>Groups</th>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Open Library...</td>
<td>Ctrl+O</td>
<td>Open Shared Library...</td>
<td>Ctrl+Shift+O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• You will see a list of all the libraries that have been shared with you. Select the shared library you want to open and click the **Open** button.

![Select a Shared Library](image)
• The library will open, looking much like any other EndNote library. Note, however, that the name of the library will show the EndNote online account name of the owner and the Share Library button will be unavailable. You cannot share a library that you do not own with others, only the owner of a library can share it.

• The next time the owner of the library looks at the list of people she has shared the library with, she will see you named as a Member of the group sharing the library instead of as Pending.

7.3 Share Groups in EndNote Online

If you do not want to share attachments, need to share references with people using older versions of EndNote or EndNote basic, need to control other users’ access rights, or need to share with more than 100 others, you can share groups through EndNote online.

With this method of sharing references, the owner of the references puts them in a shared EndNote online group. The owner of the references controls access to them, so one user could be given read-write access while another could be limited to read-only access. This method allows a large number of users to be given access to the same set of references for collaborative work. At the same time, if groups are created for specific projects, it can also allow the owner to limit shared access to only the references for a project instead of the entire library.

EndNote online data is kept on secure servers. These servers are kept in locked rooms, with strictly limited employee access, and use SSL encryption for data security.

Please note the following restrictions.

• This method allows sharing of the EndNote desktop/online record data, but does not allow sharing of attachments, even within your own organization. However, you can share links to documents stored online. So, if you have a copy of a document in a SharePoint or DropBox folder, you can share a link to the external copy of the document using the URL field.

• Groups can only be shared with other EndNote online or basic users, and you will need to know the email addresses used as account names by such users to share references with them.

Note: Screenshots below show Windows examples, but the features will work the same way on Macintosh.
7.3.1 Creating an EndNote Online Library

Please see section 5 for information on setting up your EndNote online library if you have not done so already.

7.3.2 Share Your Group in EndNote Online

- Select **Manage My Groups** on the **Organize** tab in EndNote online to see a screen like that below.

![Manage My Groups](image)

- Mark the **Share** box for the group you want to share, as shown above. You will see an icon with two people appear to the left of any shared group.

- Click the **Manage Sharing** button for your shared group to begin sharing it with others.

- Click the **Start sharing this group** link.

![Manage Sharing](image)
• You will see the Window below.

Add E-mail Addresses to 'AI: Corvids'

Enter e-mail addresses. Use the Enter or Return key to separate addresses.

endnote.anywhere@example.com

- OR -

Select a text file with e-mail addresses separated by commas.

Browse... No file selected.

- Read only - Read & Write

Note: Attachments are not shared, regardless of access privileges.

Apply

Close window.

• Add the email address(es) for those you want to share the group with, with each email address on a separate line. This must be the email address they are using for their own EndNote online/basic account. You cannot share a group with somebody who is not using EndNote online/basic.

• Select the access rights you want to give this person.
  
  o Read only access will allow them to view your references, copy your references into their own EndNote online library, or use your references in Microsoft Word, but it will not allow them to edit your references.
  
  o Read & Write access will allow them to view your references, copy your references into their own EndNote online library, or use your references in Microsoft Word, and it will also allow them to edit your references, add new references, and delete your references. Changes made to your references by others with Read & Write access will also be synchronized back to your EndNote desktop library if you are synchronizing your libraries.

• Click on the Apply button to save the options, then the Close window link.
• You should now see something like the screen below, showing who you have shared the group with and what level of access you have given them. You can change the level of access or stop sharing the group with them at any time.

![Managing group sharing](image1.png)

Note: Attachments are not shared, regardless of access privileges.

7.3.3 What the User You Shared Your Group with Will See

• The user you shared your group with will see your group show up under a **Groups Shared by Others** heading in their EndNote online library. The icon of two people with a pencil you see below will only show when they have been given **Read & Write** access to the group.

![Groups shared by others](image2.png)

• If the user the group was shared with selects **Others' Groups** from their **Organize** tab, they will see the screen below. Here they can see the EndNote online account owner of the group and can set if the group will be shown on the **My References** tab or used in Microsoft Word with Cite While You Write.

![Others' groups](image3.png)

• Note that groups and references that others share with you are not actually part of your library and will not sync to your EndNote library on the desktop.

7.4 Put a Read-Only EndNote Library on a Network Drive

If your group needs to share access to attachments as well as reference data, but for some reason cannot use EndNote Sync, needs to share attachments with more than 100 others, or is using a version of EndNote previous to EndNote X7, another option is to put a read-only copy of the library on a network drive. The library will need to be read-only because only one person at a time can access an EndNote
library with read-write access, while an unlimited number of people can access a read-only library at the same time, and because read-write libraries kept on a network drive are prone to corruption. This means one person should be in charge of the master library and keep it on their own computer, then periodically put a read-only copy of the library on the network drive.

Your network administrator can set up folders on network drives with security settings to allow only one person to add files while everybody else has read-only access. If you can enlist your network administrator’s help, this is best. Please note that you should not put a read-write copy of a library on a network drive for two reasons—

1. Only one person at a time would be able to use the library.
2. There is a risk of corrupting the library.

- When you open a read-only library, you will see a screen like the one below. Click the OK button to open the library. You will be able to use the library with Cite While You Write, search it, print from it, and do anything except change it.

- The suggested “best method” for putting your read-only copy on the network drive is to first make a compressed library with all records and all attachments on your hard drive, then copy that file to the network location and open it there. It will uncompress to create the .enl file and .data folder necessary to work in the library.

7.5 Send a Compressed Library

If you are unable to use the methods described above, you could instead send a compressed library through email, burn it to disk, or put it on a flash drive or on a shared cloud service. This method allows you to control exactly which groups of references are included, and whether or not attachments are included.

The disadvantage of this method is that users are not working with the same copy of the library. Each person would have their own copy of the library and changes to references could be made in each copy differently.
• With the EndNote library you want to compress open in EndNote, select **Compressed Library** from the **File** menu. You should then see the screen below, which you saw earlier in this chapter, but because you are not making a complete backup copy this time you can limit the references to only those you want to send.

![Compressed Library (.enlx) Screen](image)

- Select the **Create** option to create a compressed library you can save on your computer and then attach to an email. The **Create & E-mail** option will work with most MAPI-compliant email programs, but may not work with all email programs. It will not work with web email programs such as Gmail.

- Select the **With File Attachments** option to include all attachments for the references you are sending, not just the PDFs. Select **Without File Attachments** to make the file smaller and to remove PDFs and other attachments.

- The bottom part of the window gives you options on which references will be included in the compressed file.
  - **All References in Library** would include all the references in your library. This option is also an excellent way to create backup copies of your libraries. Please note that you may be unable to attach very large libraries with attachments to emails or even put them on disks because of operating system limitations on the size of zipped/compressed files.
  - **Selected Reference(s)** will include only the references you have highlighted (selected) in the library.
  - **All References in Group/Group Set** will allow you to include only the references in a specific group or group set.
• Click the Next button to see the screen below, where you can choose where the compressed library will be saved and rename it, if desired. In the example below the date has been added to the library name to help identify it later. Please note, again, that a compressed library can be saved to a cloud-syncing folder, such as the OneDrive folder in this example, but it cannot be opened and safely worked with in the OneDrive folder. The library would need to be moved out of OneDrive to be able to open it and work with it safely. See section 7.1.1 for more information on the dangers of keeping a working library in cloud storage folders such as OneDrive.

![Save Compressed Library (enlx)](image)

• Click the Save button to save your compressed library. Please note that a large library with many attachments may take a long time to compress. The compressed library will have a .enlx extension.

• The compressed library can now be attached to an email, burned to disk, or put on a network or cloud drive for distribution.

• When the recipient wants to use the library, they will need to place it on their computer in its working location, then select Open Library from the File menu in EndNote and select the compressed library file as the file they wish to open. When the file uncompresses it will become a .enl file and .data folder just as it was on the original user’s computer.

7.6 The Traveling Library

7.6.1 Using the Traveling Library to Create Bibliographies in Shared Documents

If you need only to create a Word document with references from multiple libraries, and do not need to share the actual data in the library or attachments, you can use the traveling library. This feature is only available in Microsoft Word.

Whenever you insert an EndNote citation in a Word document, you are inserting a copy of the bibliographic data for that citation in the field code for the citation. That data becomes part of the paper, and when an EndNote-using colleague works on that paper, they don’t need a copy of your library because all your citation data is embedded in the paper’s traveling library.

• Here’s an example of a simple citation and bibliography entry from a sample Word document.

```
Text (Pepperberg, 2011)

```
• However, that citation came from EndNote, so it has the data seen below “traveling” in the citation and able to be used by any EndNote user editing the paper. This data is usually invisible to the reader, but accessible to EndNote.

```
<EndNote><Cite><Author>Pepperberg</Author><Year>2011</Year><RecNum>2313</RecNum><DisplayText>(Pepperberg, 2011)</DisplayText></Cite></EndNote>
```


• Below is the same reference, but reformatted with the Vancouver style instead of the APA. That’s not anything special for EndNote. However, this citation and bibliography were formatted *with no libraries open in EndNote!* That means the only information EndNote had to work with was the data available in the traveling library.

```
```
• This means you can send a copy of your paper to a colleague using EndNote, and they do not need a copy of your library. They can add citations from their own EndNote library, and EndNote will merge your citations and theirs together to create a single bibliography.

7.6.2 Exporting the Traveling Library

Data in a traveling library can be extracted and put in your own EndNote library.

• On the Cite While You Write tab in Word for Windows, click Export to EndNote in the Tools group, then select Export Traveling Library from the drop-down list. On Macintosh with Word 2011, select Export Traveling Library from the Tools drop-down list on the floating EndNote toolbar. On Macintosh with Word 2016, select Export Traveling Library from the Tools drop-down.

Windows

Macintosh (Word 2016)

• Select the EndNote library to import the references to, or create a new library. EndNote will filter out duplicate references that came from the library you select.
• For large documents with many references, it may take some time for all the references to be exported, so be patient. EndNote will show a confirmation message when the export is complete, as shown below.

![](image1)

Windows

Macintosh (Word 2016)

• In the Word document, use the Update Citations and Bibliography command to update the citations in the paper from the new records in the open EndNote library.

![](image2)

Windows

Macintosh (Word 2016)

The method of collaboration you decide to use will depend on your situation, but hopefully this overview will help you decide which method is best for you.
## 7.7 Summary Comparison of Sharing Methods

<table>
<thead>
<tr>
<th>Features</th>
<th>Share Full Library through EndNote Sync</th>
<th>Share Groups through EndNote Online</th>
<th>Share a Read-Only Copy of Library on a Network Server</th>
<th>Share a Compressed Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can share all references and groups in library</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Can share attachments</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>All members of sharing community can edit them</td>
<td>Y</td>
<td>Y&lt;sup&gt;1&lt;/sup&gt;</td>
<td>N</td>
<td>Y&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
<tr>
<td>All changes automatically available to all members of the sharing community</td>
<td>Y</td>
<td>Y</td>
<td>N&lt;sup&gt;3&lt;/sup&gt;</td>
<td>N</td>
</tr>
<tr>
<td>Maximum number of members in sharing community (EndNote X8)</td>
<td>101</td>
<td>NA&lt;sup&gt;4&lt;/sup&gt;</td>
<td>NA&lt;sup&gt;4&lt;/sup&gt;</td>
<td>NA&lt;sup&gt;4&lt;/sup&gt;</td>
</tr>
<tr>
<td>Library owner can set read-write or read-only access rights for other members of the community</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Shared library resides on customer’s server</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>NA</td>
</tr>
<tr>
<td>Shared library resides on EndNote online server</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>NA</td>
</tr>
<tr>
<td>All members of the community working with the same set of references</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
</tbody>
</table>

---

1. If owner has given read-write permission.
2. Everyone would have separate copies of the library and could only edit their own copy.
3. Changes to the library could only be made by the owner. Others in the sharing community would only see changes after the owner uploads them to the copy on the server.
4. No set limit
8 Using the Label Field as a Custom Identification Number

The EndNote record number is not a permanent identification number and can change when using EndNote Sync, if a record is copied into a new library, or even if a record is cut and then pasted back into the same library. If you prefer an unchanging field to identify a record in both your library and for Cite While You Write, consider using the Label field in EndNote.

In your original library, you can copy the record number to the Label field for selected references. It is best to assign all Label field numbers in the same copy of the library, to be sure the number will always be unique. Remember that the new Label number may not match the record number in all copies of the library.

8.1 Set the Label Field to Show in the Library Display

Setting the Label field to show in the library display will allow you to easily see which records do not have text in the Label field, to avoid copying the record number for a record that already has data in that field.

- Open the EndNote preferences by selecting Edit, then Preferences on Windows or EndNote X, then Preferences on Macintosh.

- Click Display Fields at the left, then select the Label field from the drop-down list for the column you want to assign to the Label field. In this example column 1 is selected.
• For my example I have chosen to show both the Label field and the Record Number field, so that I can easily compare the two in my library display. Note that I have also edited the heading for the Record Number field to shorten “Record Number” to “Record #,” to reduce the column width necessary to show the heading. Click the OK button to close and save the changes on Windows. On Macintosh, click the Save button, then close the window. (Only Windows illustrations shown below.)

![EndNote Preferences](image)

• You should now see a screen showing the Label field, as in the example below. This will allow you to easily select records that do not have a number assigned to the Label field.

![EndNote library with Label field](image)

8.2 Make a Backup of the Library

If you make a mistake while copying the record number to the Label field, there is no way to undo the change, so make a backup copy of the library before starting this process. See section 5.1.1 for instructions on creating a backup.
8.3 Copying the Record Number to the Label Field

- Select all the records for which you intend to copy the record number to the Label field, then select *Show Selected References* from the *References* menu. EndNote will apply the change to all references showing in the list, so you need to limit the references showing to those you want to change.

- Select *Change/Move/Copy Fields* from the *Tools* menu.
In the Change/Move/Copy Fields window, select 1) the Move/Copy Fields tab, 2) Copy Field, 3) Record Number as the field to copy from, 4) Label as the field to copy to. You will have options to insert the record number after or before existing text in the Label field, or to replace all text currently in the field, so if you have existing text in the field it is possible to keep it and append the record number. Click 5) the OK button to apply your choices.

EndNote will report the number of references the change will apply to and which fields will be affected, and ask for a confirmation. If the message shows the correct information, click the OK button. (Reminder: There is no Undo command if you make a mistake, so check the information in this screen for accuracy and backup the library before continuing, if you have not already done so.)
• When finished with the changes, EndNote will report the number of references changed. Click the **OK** button to close the window.

![EndNote window showing made changes](image)

• The library now shows the same number for the record number and in the Label field for this library on the original computer.
• However, when that library is synced to a second computer, the record number is no longer the same for all records as the contents of the Label field. The label number will remain constant even though the record number changes, and can now be used as an unchanging tracking number and in Cite While You Write.

Please note the process above would need to be repeated whenever new references were added to the database, or the Label field would need to be manually updated. **We suggest always backing up the library before making any major changes in the library.** See section 5.1.1 for instructions on creating a backup.
8.4 Setting Cite While You Write to Use the Label Field

- Open the preferences again and 1) select Temporary Citations from the list at the left, 2) mark the box to Use field instead of record number, 3) select Label as the field to be used, and 4) click the OK button on Windows to save the changes and close the window (on Macintosh, click the Save button and close the window). This change should be made by anybody who is using the Synced library, on all their computers, so that references inserted in the document by all persons working on it will use the Label field. If someone does not set this option, EndNote can still format the citation, but it will not use the Label field information if the record is unformatted.

- In the future, temporary citations will be inserted into Word documents with the first author’s last name, the year, and the label number you assigned instead of the record number. Temporary citations should look something like this:

  {Volk, 2012, 2376}.
Index of Topics

ADMIN.bat, 6
ADMIN.zip, 6
Attachment Space in EndNote Online, 90
Backing Up a Library. See Compressed Libraries: For Backups
Browser Actions with Direct Export, 31
  Firefox on Macintosh, 33
  Firefox on Windows, 31
  Google Chrome on Macintosh, 36
  Google Chrome on Windows, 35
Capture. See EndNote Online: Capture
Capture Bookmarklet. See EndNote Online: Capture Bookmarklet
Change/Move/Copy Fields, 108
Cite While You Write, 22, 62, 68, 74, 81, 98, 99, 103
  Word 2011 for Macintosh, 81
    Adding Citations, 81
    Configuring the Bibliography, 84
    Editing Citations, 85
    Installing, 81
    Selecting Styles, 84
  Word 2016 for Macintosh, 74
    Adding Citations, 75
    Configuring the Bibliography, 77
    Editing Citations, 78
    Installing, 74
    Selecting Styles, 77
  Word for Windows, 68
    Adding Citations, 68
    Configuring the Bibliography, 71
    Editing Citations, 71
    Installing, 68
    Selecting Styles, 70
Collaboration, 89
  EndNote Online, 95
    Groups Shared by Others, 98
    Sharing Groups, 96
  How Not to Share a Library, 89
    Amazon Cloud, 89
    Box, 89
    Cloud Services, 89
    Dropbox, 89
    EndNote Read-Write Libraries on Network Drives, 89
    Google Drive, 89
    OneDrive, 89
    Sending .enl Files, 89
    SharePoint, 89
    SugarSync, 89
  Network Drives, 89, 98
    EndNote Read-Only Library, 98
    EndNote Read-Write Libraries, 89
    Send a Compressed Library, 99
    Sharing a Full EndNote Library, 90
Sharing a Full EndNote Library in EndNote X7.2 or Later
  How to Share a Library, 91
  The Basics, 90
  Summary Comparison of Sharing Methods, 105
  Traveling Library, The, 101
Compressed Libraries, 99
  For Backups, 56
  For Sharing References, 99
Creating a Site License Installer for Windows, 6
Custom installation, 9, 13, 16, 18
Customizer, 16, 17, 22, 23, 77, 81, 84
CWYW. See Cite While You Write
Direct Export, 24
  EndNote Online Plug-In, 38
  Google Chrome on Windows, 38
  PubMed, 27
    Not Using the Clipboard, 29
    Using the Clipboard, 27
  Using EndNote Online Plug-In, 63
  Web of Science, 24
    Not Using the Marked List, 25
    Using the Marked List, 24
Display Fields, 106
EndNote Library Components, 89
  Sharing. See Collaboration, See Collaboration
EndNote Online, 38, 56
Capture
  Capturing a Single Reference, 66
  Capturing Multiple References, 63
  PubMed, 64
  PubMed in Google Chrome, 65
  PubMed in Internet Explorer or Firefox, 65
Capture Bookmarklet, 64
  Google Chrome and Safari, 64
  Safari on iPad, 64
EndNote Online Plug-In, 38
Sharing Groups and References, 95
EndNote Online Plug-In, 58
  Capture, 63
  Installing
    Internet Explorer, 58
EndNote Sync, 56, 57
  Setup, 56
EndNote Windows installer, 6
EndNote X8 Site Installer.dmg, 18
ENX8Inst.msi, 6, 10
Importing Text Files, 44
  PubMed, 50
    Macintosh, 54
    Windows, 52
  Web of Science, 44
    Macintosh, 48
    Windows, 46
  Installing EndNote, 6
    For Administrators, 6
For Users, 9
  Custom Installation for a Single-User License on Macintosh, 23
  Custom Installation for a Single-User License on Windows, 16
  Custom Installation for a Site License Copy on Macintosh, 18
  Custom Installation for a Site License Copy on Windows, 9
Label field, 106
Label field for permanent ID number, 106
license.dat, 6, 10
PDF Files
  Importing, 39
    Macintosh, 40
    Windows, 39
  PDF Handling Preferences, 42
    Macintosh, 43
    Windows, 42
Preferences, Setting
  PDF Handling, 42
PubMed, 27, 28, 29, 31, 39, 64
  Direct Export. See Direct Export:PubMed
  Importing Text Files, 50
    Saving the Data, 50
record number, 106
Sharing EndNote References. See Collaboration
Site License Installer for Macintosh, The, 9
Sync. See EndNote Sync
Synchronizing Libraries. See EndNote Sync
Synchronizing References. See EndNote Sync
Typical installation, 9, 13, 18
Uninstalling EndNote
  Macintosh, 16
  Windows, 10
Web of Science
  Direct Export. See Direct Export:Web of Science
  Importing Text Files, 44
    Saving the Data, 44